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Uploading files to your Universal Library. 
You can upload KES, TXT, DOC, DOCX, RTF, EPUB, BKS, JPG, JPEG, PNG, and PDF files to any folder where 
you have Write Access. 

1. Navigate to a folder where you have Write Access. The Upload button is enabled.  

 

2. Click the button. A Select file window appears which lets you navigate to the folder containing 
your files.  

 

3. Highlight the file you want to upload, and click Open. The file is uploaded to your folder. 

4. You can then open the file in the Reader. 
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Using the Reader. 
Navigate to the folder that contains the document you want to open. Click the document name to open 
it. Note that the check box preceding the document name is used only to select it for copying, moving, 
or deleting. 

If the document is password protected. 
If a password has been added to a file in Kurzweil 3000 for Windows, Kurzweil 3000 for Macintosh, or 
Kurzweil 3000 for Web Browsers, you will be prompted to enter the password before the document is 
opened.  

 

After you enter the correct password, the document opens.  

If the document has been Zone Edited in Kurzweil 3000. 

Secondary zones. 
Secondary zones created in Kurzweil 3000 Web License Edition for Windows and Macintosh are 
recognized in Kurzweil 3000 on your Browser. Secondary Zones are displayed but not read. This is useful 
for sidebars and other information that are secondary to the main text. The zone can be read aloud if 
the user clicks in the secondary zone area.  

For information about setting Secondary mode in zone editing, refer to the Kurzweil 3000 online help 
topic: Setting Zone Properties. 

Silent zones. 
Silent zones created in Kurzweil 3000 for Windows are recognized in Kurzweil 3000 on your Browser.. 
You will see the reading highlights, but the voice is not heard.  

This feature is useful in test taking. For information about setting Silent mode in zone editing, refer to 
the Kurzweil 3000 for Windows online help topic: “Setting Zone Properties.”  
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The Reader toolbar. 
When the document opens, the Reader toolbar appears at the top of the open document, containing 
buttons and drop-down menus. The buttons shown will depend on the type of document. The buttons 
shown below are for documents that can’t be edited – PDF, EPUB, BKS, JPG, JPEG, PNG, and KES image 
files. 
 

 

They are: 

1.     Main menu.  
2.     Audio Options menu.  
3.     Bookmark button. 
4.     Reading Navigation: Go Back one Reading Unit.  
5.     Reading Navigation: Read (Play/Pause toggle).   
6.     Reading Navigation: Go Forward one Reading Unit. 
7.     Audible Reading toggle. 
8.     Highlight menu.  
9.     Document View menu. 
10.   Document Notes menu.  
11.   References menu. 
12.  Tools menu. 
13.  Edit Underlying Text button. 

Navigation shortcut keys. 
 Chrome Edge Firefox Internet Explorer Safari 
Zoom In + + CTRL + + + 
Zoom Out - - CTRL - - - 
Play/Pause* P P P P P 
Go Back* V V V V V 
Go Forward* N N N N N 
*Reader only. Only the Zoom shortcuts work in both the Reader and Editor. 

 

 



 
Using Kurzweil 3000 for Web Browsers       Page 24 of 99 
                
 

Main drop-down menu. 
The Main drop-down menu lets you move to your Universal Library, your Account destinations, and the 
Help topics. 
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Changing the reading settings. 
To change reading settings, click the Audio Options button. The settings you choose are saved as your 
preferences.  

 

Set options for: 

• Voice: Use the drop-down menu to select a voice. 
• Reading Speed: Faster, Slower. 
• Skip Reading Headers/Footers: Toggle checkmark On/Off. If it is checked, text marked as a 

Header/Footer will not be read aloud. See Editing Header/Footers in an Image Document that 
you own. 

• Unit: Word, Line, Sentence, and Paragraph. 
• Mode: Continuous, Self-Paced, and Word-by-Word. 
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Viewing image documents.  
Image Documents can be viewed as a series of thumbnails for easy selection of a page to open. You can 
also specify the zoom level of a document, rotate pages within the document and display Bookmarks 
and Bubble notes. 

 

Thumbnail view. 
The thumbnail view allows you to see a small image of each page. This makes it easy to quickly and 
visually identify pages that you want to open.  

1. To view the thumbnails of an image document you have opened, just click Thumbnail View on 
the Document View drop-down menu. 

Note: If the document is long, or if this is the first time you have opened the document, some of 
the thumbnail images may display slowly. If there are thumbnail images that don’t display, just 
click Thumbnail View again and those pages should display. You can also open the longer 
document in Kurzweil 3000 and break the document into smaller parts, perhaps by chapter, 
using the Save Page Range feature. Then re-save the smaller document(s) to the universal 
library. 
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2. To open a page, just click the thumbnail of the page you want to open. For example, you may 
want to go directly to the first page of a particular chapter. The page opens and replaces the 
thumbnail view. 
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Document zoom. 
1. To change the zoom setting of an open image document, click the Zoom button. (Note that 

Document Zoom is grayed out (not available) while the document is in thumbnail view, but is 
enabled after a page is opened and the thumbnail view closes.) 

 

2. Choose a range from 25% to 300% or check the Fit to Width option to fit the document to the 
browser window width. Note that the Zoom menu is not available for documents that can be 
edited. Note that you can also use the zoom shortcut keys (see Navigation shortcut keys). 

Rotating a page. 
The orientation of an image document page opened in the Reader can be changed with the Rotate Page 
feature. 

1. With the page open that needs rotating, open the View menu.  

2. Click Rotate Page Right, Rotate Page Left or Flip Page depending on how you want to orient the 
page. 

The page orientation will be automatically saved and is visible when the document is opened in Kurzweil 
3000 on your Browser, Kurzweil 3000 Windows and Macintosh, and Kurzweil 3000 for the iPad. 

Note: Processing page rotation by Kurzweil 3000 for web browsers may take some time on larger image 
files. 
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Changing the background color of a document. 
When viewing documents in the Reader, you can select a background color from the Tools menu in 
which to view the document. The selected background color view is saved as a preference and seen 
wherever the user logs into Kurzweil 3000 from their Browser. 

 

Notes: 

• With some browsers if Windows high contrast display themes are being used, the background 
colors cannot be changed. 

• This is a color used to 'view' a document.  The actual color of the document is not changed, for 
example it will print with a white background.  

• The background color for viewing documents in the Reader can differ from the color being used 
in the Editor. 

• If you select Gray, Slate, or Granite as a background color, it’s best to choose a contrasting color 
if using highlighting. Otherwise it may appear that the highlighting is missing. 
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Using Bookmarks in Image Documents. 
The Bookmarks feature in image documents allows you to Add Bookmarks, View Bookmarks, Go to 
Bookmarked text, and Delete Bookmarks. You can also extract bookmarks along with notes and 
highlights. 

 

1. Click the Bookmark button.  The Bookmarks window displays and existing bookmarks are 
displayed. 

 

2. Under List Bookmarks in, select the order in which to sort the bookmarks: 
• Alphabetical order. 
• Reading order.  

Reading order is the order in which the bookmarks appear in the document. 

3. To add a Bookmark, select the text in the image file that you want bookmarked, then click the 
Add button. The Bookmark is added to the list and the Bookmark window is closed. 
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4. To hear a Bookmark read out loud, click the Bookmark Button, select a Bookmark in the list and 
it will be read out loud. Click Ok to close the Bookmark window. 

5. To go to a Bookmark in your document, click the Bookmark Button, then select the bookmark in 
the list, click the Go To button at the bottom of the window. The Bookmark window closes and 
the cursor jumps to the location of the bookmark. 

6. To delete a Bookmark, click the Bookmark Button, select the bookmark in the list, then click the 
Delete button. The Bookmark is deleted and the Bookmark window closes. 

Notes:  

• It is possible for the Bookmarks window to show no bookmarks while a document is still 
loading.  

• If the document is long and has many bookmarks, the bookmarks may display slowly. 
Consider opening the document in Kurzweil 3000 and breaking the document into smaller 
parts, perhaps by chapter, using the Save Page Range feature. Then re-save the smaller 
documents to the Universal Library.  

• Some .kes files will not display bookmarks. Documents of the .opf, .bks, or .epub file types 
that were saved as .kes files will not display bookmarks. For example, if “Book about 
cats.bks” becomes “Book about cats.kes” in Kurzweil 3000, the bookmarks will not be seen 
in Kurzweil 3000 for the Browser. 

• Bookmark changes (added or deleted) for files with a file extension of .epub and .bks, will 
not be seen when the .bks and .epub files are opened in Kurzweil 3000 Windows or 
Macintosh. 

Hiding Bookmarks. 
To hide Bookmark icons, deselect Show Bookmarks in the Document View menu’s Display Tools section.  

 

This setting will be in effect while the document is open. The icons will automatically display again when 
the Bookmarks button is selected in the next document with bookmarks that you open. 

Reading a document. 
• Click the Play/Pause toggle to read using dual highlighting.  Each word and Reading unit are 

highlighted in two different colors. The cursor is moved forward by the Reading Unit option 
selected. By default, the Reading unit is set to sentence. 



 
Using Kurzweil 3000 for Web Browsers       Page 32 of 99 
                
 

Note: If a reading zone has been overridden in a file edited in Kurzweil 3000 for Windows or 
Mac and saved to the Universal Library, Kurzweil 3000 for Web Browsers is able to read the 
overridden text in the zone.  

• Click the double arrows on the left of the Play/ Pause button to go back to Previous Reading 
Unit; click the double arrows to the right of the Play/Pause button to advance to the Next 
Reading Unit.  

• Click the Audible Reading toggle button to turn the sound on or off.  

• Open the Audio Options drop-down dialog and check or uncheck Skip Reading 
Headers/Footers. The default is checked (to skip). (Refer to the Documentation Preparation 
section of the Kurzweil 3000 online help and choose The Header/Footer Editor for topics on 
marking text as Header/Footer). 

Note: When using Safari, if reading audio is not heard after turning your volume up, check your 
Safari settings for kurzeil3000.com. In Safari, go to the Kurzeil3000 login page, and right click in 
address bar.  

 

 

Select "Settings for This Website" and make sure that the Auto-Play setting is "Allow All Auto-Play.” 
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Navigating pages. 
• To navigate to the previous page or Next page, click the large Left Arrow or Right Arrow button 

on either side of the page display. 

 

• To go to a specific page, enter the page number in the Go to page box at the bottom left of the 
window, and then click the Go button or press Enter. 

 

Using References – Dictionary and Translation. 
The References drop-down menu allows you to look up a selected word (Dictionary) and translate 
selected text (Translation). 

 

Note:  You can also choose Picture Dictionary from the Dictionary drop-down menu. 


